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General Flash Information
Adobe Flash is a software authoring tool for
creating scalable, interactive animated graphics and navigation controls for the Web. Flash
is also one of the most popular add-on tools for
internet browsers and is currently available on
most browsers throughout the Internet. Flash
is known for creating Web graphics that are
small in size but dynamic in sound, motion and
graphics.


Starting Flash
To begin Flash on a Macintosh, look on the Macintosh
lower toolbar inside the Applications folder and doubleclick on the Flash application. On a Windows system
to startup Flash, click under the Start icon then select
All Programs, Adobe Design, then Adobe Flash.
From the Flash starting screen— press Flash File (Actionscript 2.0) under Create New; this will start a
Flash project for you and allow you to see the distinct
areas within Flash. For the Flash layout for today’s
class, pull down in the upper right to Designer then
pull the Properties panel under the main Stage and
pull the dividing line on the left to be two columns
wide. Next pull down under the layouts on the upper
right and select New Workspace then save this setting
as Classicplus.
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Flash Layout
There are five distinct areas within Flash: the
Drawing Toolbar, Menubar, Timeline, the
Stage/Work Area, and the Floating Panels
which includes the special Properties Panel.

You work in the Stage area using tools from the Toolbar. You must select the image frame on which you are
working from the Timeline and the Floating Panels give
you information on the currently selected Stage item
and allow you to alter that item.
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Drawing Toolbar Area
Toolbar Tools
The Drawing Toolbar has four distinct areas:
the tools area and the view, color and options sections. The Tools area has all the
drawing tools that you can use on the Stage-

More of these tools are very similar to the ones used in
Photoshop and are self-explanatory. The White Arrow
or Subselection tool is a unique tool for Flash that allows
you to view and modify anchor points. Any tool with
a lower right arrow means that the tool in question has
additional related tools underneath. For instance, if you
pull down under the Free Transform tool then you will
find the Gradient Tool.
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Timeline Area
The Timeline area shows you what is happening at a particular time on the Stage. The
Frames area shows how many frames are in
your Flash presentation and extends to the
right. The Playhead within the Frames shows
which Frame is currently showing on the Stage.
Each Frame can have multiple Layers with each
Layer containing the actual content of the Flash
Movie. Movie elements that shouldn’t be grouped
together need to be on separate Layers. Like,
for instance, you would probably create a separate Layer for your Flash Sounds or Buttons.
You can even have Layer folders which are
groups of Layers.

4



Floating Panels Area
The Panels area contains information or options for the currently selected stage item or
tool. Panels float so that you can move them
anywhere you want on your screen. The Panel
tools that are most often used are Properties
(object/tool information), Color (color mixer),
Behaviors (Simple Scripts) and Components
(specialized tools).
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Project- Photo Gallery
Our first project will be to create a simple
photo gallery using buttons.
Adding Some Gallery Images
Make sure the Timeline Playhead is on frame
one then press F5 six times to create six new
frames. Next open up a browser and go to
css.ait.iastate.edu/Flash/Data2/ and right-click
or ctrl-click the GalleryArchive file. Extract
the GalleryArchive file and then take the images inside the archive and move them to your
desktop.
Next go under File and pull down to Import then over
to Import to Library. You are going to import seven
images for your photo gallery. Choose any 7 images
to import then click on the Import Button in the lower
right. You can import most standard image/sound files
into Flash.
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Putting the Images into Frames
Pull down under Window to Library to show
the Library for this project which should show
the names of all of the images. Select Frame
1 with the Playhead and click in the Layer
1/Frame 1 box. Take one of the images and
place it onto the Stage.
Next go to Frame 2 with the Playhead and
pull down under Insert to Timeline then over
to Blank Keyframe. We want to get rid of
the old image from frame 1 and then declare
frame 2 a Keyframe so that we can put a new
image there. A Keyframe tells Flash that there
is something new or significant in this frame.
Next pull another image from the Library onto
the Stage.
Note: If you ever make a mistake and want
to get rid of a keyframe, select the keyframe
that you want to remove then pull down under Modify to Timeline then over to Clear
Keyframe.
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Continue on to Frame 3 now and do exactly
what was done in frame 2. Do this for Frames
4–7 as well. When you finish, you should have
seven images with each image being in its own
Keyframe.

Pull down under File to Save As and save
your Flash file to the desktop. You can try out
your movie by scrolling the Timeline along the
Playhead known as scrubbing or you can also
run your movie by pulling down under Control
to Test Movie.
If you test the movie, you’ll find out that the
images play one right after another rather quickly
and then loop back to the front. Maybe we
need to slow things down a bit.
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Stopping the Action
The Behaviors panel is used to add simple interactive actions to frames, sumbols and other
objects within Flash. Create a new layer by
going under Insert → Timeline → Layer and
click on the layer name and rename the layer to
Actions. Create a blank keyframe in frame
2 of the Actions layer. Next select Frame
1 in the Actions Layer and click off the main
stage area. Next go to the Behaviors Panel
and click on the Plus sign then drag down to
Movieclip and over to Goto and Stop. Take
the default options and click on OK.

You should now see that on frame 1 of the Actions layer
there is a small a on it denoting that it now has a frame
action. Go and test your movie again and you will find
that it now only shows the first frame. Now we just
need to add a few buttons to tell Flash to advance to
either the next or previous frame.
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Adding Some Buttons
Create a new layer for your buttons by pulling
down under Insert to Timeline then over to
Layer. Double-click the layer name and name
the layer ’Buttons’. Select Frame 1 in the
new Buttons Layer. Pull down under Window
to Common Libraries and over to Buttons.
Within Classic Buttons, double-click the Circle Buttons folder and drag one Circle with
Arrow out onto the stage and place it just
below the image that is already there.
You can resize this button by selecting it and
then pulling down under Modify to Transform
and then over to Scale. This will cause scale
handles to appear around the arrow. Simply
drag one of the corner handles to scale the
arrow then click away from it when finished.
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Click the Pointer Tool then select the arrow
button. Now we are going to copy the arrow
to create a second arrow just like it.
Pull down under Edit to Duplicate. Select the
new Arrow. Now pull down under Modify to
Transform then over to Flip Horizontal. Now
the new arrow is a Left Arrow and is scaled
exactly the same as the Right Arrow. Arrange
the Left Arrow properly under the image.

Now we just need to tell the arrows which actions to perform when they are clicked.
11



Adding Button Actions
Select the Right Arrow and click on the Plus
button button in the Behaviors panel then
slide down to Movieclip and over to Goto and
Stop. Take the default options and click on
OK. This isn’t exactly what we want but we
will alter it in a minute. Do the same thing for
the Left Arrow.

You can alter standard Behavior actionscripts by using
the Actionscript Panel button. Select the Right Arrow
again then click on the Actionscript Panel button in
the Properties Panel.
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Note: Remember this is an action that is being applied
to a button. So it should say Actions - Button in the
upper left of the Action Script. If it doesn’t, close the
Action Script. Re-select Frame 1 of the Buttons Layer.
Click on the Stage away from the button and then click
on the Right Arrow button again. A blue rectangle
should be in evidence around the button. If necessary,
reapply the behavior to this button then click on the
Actionscript Panel button again.

Within the Actionscript, change “1” in parentheses to nextFrame(), remember to get rid
of the double quotes, then close the Window.

Do this for the Left Arrow as well but this time
change “1” to prevFrame(). Test your movie
and your buttons should move you from frame
to frame.
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Fixing a Small Problem
You should now be able to use the buttons to
browse through your photo gallery. The only
problem is that the Right button does nothing in the last frame and the Left button does
nothing when the movie is in the first frame.
To fix this make sure you are on the Buttons
Layer and create Keyframes by pulling down
under Insert to Keyframe while you are in
Frame 2 and Frame 7. We’ve now isolated
out frames 1 and 7 as different keyframes that
we can alter separately.
Select Frame 1 in the Buttons Layer. Now go to the
Properties Panel and click in the Frame Name box.
Next type the word First in that box. If you do this
properly, a red flag will occur within that frame on the
Timeline. Do the same thing in Frame 7 and name it as
Last. You now know how to create frame names previously called frame labels within Flash. Naming frames
allow you to jump to a named framed instead of to a
frame number which can help you in Actionscripts.
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Now select Frame 1 of the Buttons Layer again
and next select the stage then click the left
arrow. Press the Actionscript Panel button
within the Properties panel. Within the Action Script, change prevFrame() in parentheses to “Last”, remember to get add the double quotes this time, then close the Window.
Instead of going to the Previous Frame, we
want this button to go to the Frame labeled
“Last”.

Click on Frame 7 of the Buttons Layer, click on the
Stage then click the Right arrow. Next do this same
alteration for the Right Arrow as you did for the Left
Arrow but this time change nextFrame() to “First”.
Save and test your movie. You should now find that
both buttons always work properly.
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The Photocube— no buttons
One of my favorite tricks, is to use the picture
itself as a button. To do this, go to Frame 1 in
Layer 1 and select the image there. Pull down
under Modify to Convert to Symbol. Type
the name ’pic1’ for the symbol and choose the
Behavior as a Button. The pic1 symbol appears both on the Stage in place of the image
file and in your Library.
Converting the image to a symbol allows Flash
to interact with that image and cuts down on
space costs if the symbol is used more than
once. You can now select the pic1 symbol and
edit its actions just like a button. Go to the
Behaviors panel and click on the Plus button
then slide down to Movieclip and over to Goto
and Stop. Choose to stop on frame 2 then
click on OK.
You could change all the images in this movie to do
this (with the last frame button going back to frame 1)
and thus get rid of the need for the arrow buttons all
together.
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Having Buttons Go Anywhere
Insert a new Layer and go to frame 1. Open
the Buttons’ Common Library, choose any
classic arcade button and place it on the Stage.
Next to the button, use the Text Tool and
type on the Stage ’Press this button to continue − >’.
Select the new button on the stage so that it
alone is highlighted in blue. Next go to the Behaviors Panel and click on the Plus sign then
drag down to Web and over to Go to Web
Page. In the URL: box that opens up enter
http://css.ait.iastate.edu. You can change
the Open in: box so that the new page opens
in a new window by selecting “ blank”. Click
OK, save and test your movie.
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Optional - Background Sound
Many people like to have a little background
audio running while they are showing their pictures and this is fairly easy to add in Flash.
Flash can handle most standard audio files and
Flash categorizes the use of a sound as either an event sound that occurs at a particular
frame or as a streaming sound which is used
throughout a Flash scene.
Pull down under File to Import and over to Import
to Library and import the sound jazzie.mp3 from your
desktop. Next create a new layer named Music and
move the Music Layer to be the bottom layer in your
stack. Select the first frame in the Music layer and
in the Properties panel on the far right choose Sound,
Name: jazzie.mp3 and Sync: Event to occur on that
frame. You can also choose to repeat the sound or to
just play it once. Save your file then Test your Movie.
On the Buttons layer to keep the sound from repeating over itself, you will need to do two things. First
make frame 3 into a keyframe which isolates off frame
2. Then second, add a “stopAllSounds();” line before
the this.goto line in the Actionscript of both the left or
previous button in frame 2 and the right or next button
in frame 7.
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Optional - Random Starting Picture
This one is a fun effect. If you want, you can have Flash
jump to a random starting picture by adding a preloader
to your Flash file. A preloader tells the viewer that the
file is loading but here it is being used to give the randomizer the ability to jump to a random frame.
Create two new blank Keyframes in frame one and
two for all your layers and make a new top Layer
named Navigation. Create a keyframe in frame 2
and 3 of the Navigation layer and Name frame 1 load
and frame 2 Ready.
Create a two frame movie symbol with the word Loading in two different colors in frame one and frame two
and place that movie in frame 1 of the Navigation
Layer. This lets people know that the images are loading and gives the randomizer time to work.
Open the file preloader.txt with your favorite local
text editor. Create a frame action in frame 1 of the
Navigation Layer and cut and paste the text from the
preloader file to be the frame action in frame 1. You
can ctrl-click inside of an Actionscript to paste in script
infomation. All this preloader does is wait until all the
frames have loaded and then moves to the frame named
“Ready”.
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Preloader script:
stop();
_root.onEnterFrame = function()
{
if (_root._framesloaded == _root._totalframes){
if (_root._totalframes > 0) {
delete _root.onEnterFrame;
_root.gotoAndStop("first")
}
}
}
In the second frame of the Navigation Layer add this
frame action:
start = Number(Number(int(Math.random()*8))+3);
gotoAndStop(start);
8 should be the number of pictures that you have. The
script picks a number from 0–7 adds 3 then jumps to
that frame number. Remove the original actionscript
from Layer 1 Frame 3. Save and Test your movie.
To fix the sound, have the sound start on Frame 2
and then remove the stopAllSounds(); actionscript lines
from the button Actionscripts which we added earlier.
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Advanced Optional - A Preview Gallery
Another type of Photo Gallery you can produce with
Flash is one where you see miniature versions of a picture and click them to see the large version of a picture.
This is an interesting type of item to produce with Flash
as it shows how Flash can use one object to control another object within a Flash document.
Create a new Flash Actionscript 2.0 project. Import
any four of our images into the Library of the new
project. Put the four objects onto the stage and miniaturize them by selecting them, then pulling down under
Modify to Transform then over to Scale and Rotate.
Scale them down to around 25%.
Next pull down under Insert to New Symbol and create
a new symbol named strip which is a Movie clip. Add
four additional blank keyframes to strip. In frames 2,
3, 4 and 5 of strip, put in the full size version of the
pictures. In frame 1, put in a frame stop( ); then add a
copy of the image in frame 2 but convert the image into
a graphic object with Modify → Covert to Symbol.
Then set the Alpha level on this new object to around
25% then return to the Main Timeline. This shaded
object will show the viewer that a full-sized gallery is on
the stage for viewing.
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Take an instance of strip and place it onto your main
timeline. Here’s the tricky part. . . Once you place
the instance of this object on the timeline, you need to
name the instance in the properties panel— name the
instance of this movie clip photo. Naming an instance
of an object, allows you to easily refer to it in another
object’s actionscript.

After that it is pretty easy, just click on each on of
the miniature images, convert each to a button symbol,
then pull down under the blue plus sign in the Behaviors
panel to Goto and Stop at Frame or Label, choose
the photo object and tell it which frame to go to within
the photo object. Do that for each of the miniature
photos. This type of photo gallery is very popular on
the internet and is not too hard to setup in Flash.
Additional things you might try: 1.) See if you can
add a transition between your slides in either type of
photo gallery; 2.) Try to add a background image that
slides behind your photo gallery; 3.) Integrate the photo
gallery into a web page design so that appears to be just
part of the page; or 4.) Create a gallery that moves
from slide to slide on its own— Hint: consider doing
this with a very low frame rate.
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Project- A Quick Button Menu
This project creates a quick button menu that
can be added to almost any Web page.


Adding Some Buttons
Start a new project by pulling down under File
to New and choose an Actionscript 2.0 Flash
File. Then open the Classic Buttons in the
Common Library and under Arcade Buttons,
select three different colored Arcade Buttons
and drag them onto the stage. Place the buttons so they are about equally spaced out along
the top of the stage.


Altering a Button
Double click on one of the buttons on the stage and
you will be placed into the internal design of that button.
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We want to alter the standard button and personalize it a little bit. Notice that the button
has four states: Up, Over, Down and Hit. The
Up state is the starting state. While the Over
state is when the mouse is rolled-over the button. The Down state is used when the button is clicked and the Hit state shows the “hit
area” of the button which is usually a little
larger than the button itself.
Add two new Layers to the button and name
the Layers Title and Splash. Do this by pulling
down under Insert to Layer and then doubleclicking the standard label name to change it.
Make sure the Title layer is above the Splash
layer.
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Select the Over state of the Splash Layer and
make a Keyframe by pulling down under Insert → Timeline → Keyframe. Select the
Paintbrush and a splashy color like red then
splash paint all over the button making sure to
go outside the button itself.
Select the Over state of the Title Layer and
make a Keyframe. Then select the Text Tool
switch the color to Black and write the following below the button ’IT Learning Pods’.

Optional: If you would like to add sounds to your buttons, import banjo2.aif or lock.aif from the class web
site. Create a new layer in the button named Sounds
and move it to be the bottom layer. Make a keyframe
in the Down state of the Sounds layer and add banjo2.aif
or lock.aif as an Event sound in that keyframe.
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Repeat the Process
We’ve now personalized the button. Go back
to the main scene by clicking on the Scene
1 icon and save your project by pulling down
under File to Save As.
Repeat this process with the other two buttons but give them the titles: IT Services
and Ebay. Under Modify → Document you
might want to change the height of your movie
so that the buttons and rollover text just fit
into the Flash document.
Save your movie again and then test it by pulling down
under Control to Test Movie. As you glide over each
of the buttons, the text message and the splash area
should show up. Now let’s make the buttons do something.


Adding an Action to each Button
Make sure you are in Scene 1 then using the Arrow
Tool, select the first button again. Next go to the Behaviors Panel and click on the Plus sign then drag
down to Web and over to Go to Web Page.
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In the URL: box that opens up enter the IT
Learning Pods URL of http://css.it.iastate.edu/
and change the selector in the Open in: box
so that “ self” is selected.

Click OK then save and test your Movie. The
first button should now take you to the IT
Learning Pods site if your browser is currently
active.
Now go back and add Web Page actions to
the other two buttons sending them to
http://www.it.iastate.edu and
http://www.ebay.com respectively.
You can then Publish the movie and use that
as a menu on your Web page.
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